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Genesys Web Engagement Quick Start Guide

Genesys Web Engagement Quick Start
Guide

Welcome to the Genesys Web Engagement 8.5 Quick Start Guide. In this guide you'll find steps to get
Genesys Web Engagement up and running quickly by installing and working with the Playground
application.

Get started!
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Getting Started with the Playground Application

Getting Started with the Playground
Application

The fastest way to get started with Genesys Web Engagement is to use the Playground application,
which is included in the Genesys Web Engagement installation package; after you install GWE, you
can find the application in the GWE_installation_directory\apps\playground folder. Then you just
build and deploy it and you are ready to work with the features of Genesys Web Engagement.

Read below to learn more about the application or continue on to "Installing Genesys Web
Engagement" for installation details and running the Playground application.

* Read more — Playground application
The Playground application not only includes a Web Engagement application, but also a functioning sample website you can use

to test and demonstrate Web Engagement's functional capabilities. This allows you to see Genesys Web Engagement at work on
a website that is designed to highlight the GWE features and show you how to use them.
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The Playground website was created using Bootstrap and works on all web browsers that support Bootstrap. See the Bootstrap
documentation for details: http://getbootstrap.com/getting-started/#support

* Read more — GWE components
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Genesys Web Engagement Components

You should be familiar with the following Genesys Web Engagement components before you dive into the Playground application:

» DSL File

» Categories

* Instrumentation Script

* Rules Files

* Strategies

* Widgets

* Configuration Options

* Monitoring Agent API

DSL File

The DSL file is used to manage and customize business events. When you create an application, a set of Domain Specific
Language (DSL) files that are used by your application is also created. These files are defined in the apps\Your application
name\resources\dsl\ directory. You can use the DSL to define Business events (read about the structure of these events here)
that are specific to your solution needs.

Default domain-model.xml

The domain-model.xml is the main default DSL file for your application:

<?xml version="1.0" encoding="utf-8" 7>

<properties>
<events>
<!-- Add your code here
<event id="" name="">
</event>
-->
<!-- This is template for your search event -->
<!--
<event id="SearchEvent" name="Search">
<trigger name="SearchTrigger" element="" action="click" url="" count="1" />
<val name="searchString" value="" />
</event>
-->
<event id="TimeoutEvent30" name="Timeout-30" condition=""
postcondition="document.hasFocus() === true">
<trigger name="TimeoutTrigger" element="" action="timer:30000"
type="timeout" url="" count="1" />
</event>
</events>
</properties>

By using the <event> element, you can create as many business events as you need. These events can be tied to the HTML
components of your page and can have the same name, as long as they have different identifiers (these identifiers must be
unique across the DSL file, to make a distinction between the events sent by the browser). It can be useful to associate several
HTML components with the same event if these HTML components have the same function. For instance, you can define several
events associated with a search feature and give all these events the same name: "Search".
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For each event, you can define triggers which describe the condition to match in order to submit the event:
» Triggers can implement timeouts.
» Triggers can be associated with DOM events.
* You can define several triggers for the same event (see <trigger> for further details).

Each trigger should have an element attribute that specifies the document's DOM element to attach the trigger to, and the
action attribute, which species the DOM event to track.

You can specify standard DOM events for the action:
* Browser Events
* Document Loading
* Keyboard Events
* Mouse Events
* Form Events

In addition to the standard DOM events, the DSL supports the following two values: timer and enterpress.

The following example generates a "Search" event if the visitor does a site search. The "searchString" value is the string entered
in the "INPUT.search-submit" form.

<event id="SearchEventClick" name="Search">

<trigger name="SearchTrigger" element="INPUT.search-submit" action="click"
url="" count="1" />

<val name="searchString" value="INPUT.search-submit" />
</event>

If the DSL uses the optional condition attribute, the event's triggers are installed on the page if the condition evaluates to true.
The following example creates a Business event with a time that can be triggered only if the text inside the <h1> tag is
"Compare":

<event id="InactivityTimeout4CompareProductsEvent"

name="InactivityTimeout4CompareProducts" condition="$('hl"').text() == 'Compare'">
<trigger name="InactivityTimeout4CompareProductsTrigger" element=""

action="timer:10000" type="timeout" url="http://www.MySite.com/site/olspage.jsp"

count="1"/>

</event>

If the DSL uses an optional postcondition attribute, this can manage how an event is generated by checking a condition after
the actions are completed. The following example creates a Business event timeout by timer if a page is in focus. In this case, the
event does not generate if the page is opened in the background:

<event id="TimeoutEventl0" name="Timeout-10" condition=

postcondition="document.hasFocus() === true">

<trigger name="TimeoutTrigger" element="" action="timer:10000" type="timeout"
url="" count="1" />
</event>

A DSL trigger can use the type attribute. This can have a value of either timeout or nomove, which specifies how the timer
action works. If the type is timeout, then the timer interval begins after the page is loaded. If the type is nomove, then the timer
resets each time the user moves the mouse.

You can also apply the optional url attribute. This attribute defines the URL of the specific page that raises the Business event.
The Business event is not submitted if the current document's URL does not match the URL parameter.

Finally, you can apply the optional count attribute. This attribute specifies how many times the trigger needs to be matched
before the event is generated and sent to the Web Engagement Server.

For more information about the DSL elements, see the Business Events DSL.
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Categories

You can use the GWE Plug-in for Genesys Administrator Extension to define, in a few clicks, Web Engagement categories that
contain business information related to URL or web page titles. These categories are used in the CEP rule templates, which
provide rules that define when to submit actionable events to Web Engagement — this is what starts the engagement process.

For example, lets look at Solutions on the Genesys website. In this scenario, you can define a Solution category associated with
the http://www.genesys.com/solutions page and several or all solution sub-pages, such as http://www.genesys.com/
solutions/cloud or http://www.genesys.com/solutions/enterprise-workload-management.

» To associate the category with all the pages containing the "solutions" string in the URL, you can
create the "solutions" tag. This tag defines the "solutions" string as a plain text expression to search
in the events triggered by the visitor browsers.

* To set up a specific list of sub-pages for the Solutions category, you can create a tag for each sub-
page:

e The "cloud" tag, which defines the "cloud" string as the plain text expression to search in the
events triggered by the visitor browsers.

¢ The "enterprise-workload" tag, which defines the "enterprise-workload-management" string as
the plain text expression to search in the events triggered by the visitor browsers.

Now your rules can use this category to match solution-related pages.

Instrumentation Script

The Tracker Application instrumentation script is a small piece of JavaScript code that you paste into your website to enable Web
Engagement functionality. You create this script by using the Script Generator in the Genesys Web Engagement Plug-in for
Genesys Administrator Extension.

Rules Files

Genesys Rules System (GRS) provides the ability to develop, author, and evaluate business rules. A business rule is a piece of
logic defined by a business analyst. These rules are evaluated in a Rules Engine based upon requests received from client
applications such as Genesys Web Engagement. GRS implements the CEP (Complex Event Processing) template for GPE. This
template type enables rule developers to build templates that rule authors then use to create rules and packages. These rules
use customized event types and rule conditions and actions. Each rule condition and action includes the plain-language label that
the business rules author will see, as well as the rule language mapping that defines how the underlying data will be retrieved or
updated.

The Playground application has a pre-built rule file, called rule.com.playground.drl, located at
GWE _installation_directory\apps\playground\resources\drl. The rules included in this file demonstrate the basic concepts
of how Genesys rule files are used.

Singleton

The rule receives each single event as a formal
parameter. If the event's value matches the right
category, then the actionable event is sent to

"Rule-101 singleton"
the Web Engagement Server.

T | { )
. ={ Wait for event mtega::e-"mﬂnw"j Actionabletvent) >@

When
page transition event occurs that belongs to
category $category

Expression Example
Then

generate actionable event
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Sequence

"Rule-108 sequence"

Expression Example

Set

"Rule-136 Set"

Expressions

Counter

This rule analyses the event stream received
from the categorization engine and builds the
sequence of events by category values. As soon
as the event sequence is completed, the
actionable event is submitted. Note that the
event sequence must follow a specific order.

When
page transition event occurs that belongs to
category $categoryl save as $eventl

and

event following $eventl with category
$category2 save as $event2

(..

and
event following sevent” ! with category
$category” save as $event”

Then

generate actionable event based on $event”

This rule analyses the event stream received
from the categorization engine and collects the
events by category values. As soon as the event
set is completed, the actionable event is
submitted. If you use this rule, the event order is
not taken into account.

When
page transition event occurs that belongs to
category $categoryl

or
page transition event occurs that belongs to
category $categoryl

or

page transition event occurs that belongs to
category $category"”

Then

generate actionable event
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"Rule-122 counter"

Expressions

Strategies

This rule analyses the event stream received
from the categorization engine and counts
events which occur for a given category. As soon
as the counter is reached, the actionable
actionable event is submitted.

When
Category $category counts $count times

Then

generate actionable event

When you create your application, Genesys Web Engagement also creates default chat routing and engagement logic strategies
in the \apps\application_name\resources\_composer-projects\ folder. Orchestration Server (ORS) uses these strategies to
decide whether and when to make a proactive offer and which channels to offer (chat or web callback). You can modify these

strategies by importing them into Composer.

The following shows the Chat Routing workflow, where interactions are routed to agents with "Customer Service" or "Customer

Care" skills:

o e el 1

[ Package Explorer &3 BE Tl
- 52 webEngagement_CEPRule_Templates_plawground

=i WebEngagement_ChatRouting

| 11 = W Fa 1= | L || e =l

o “webme_chat_workworkflow £3

E-E db
& *? i . It s possible bo send mes:
B g5 Interaction Processes routed ko an agerk. Enab
i | B META-INF demonstration of this fiea
= Reports
S sre
B sre-gen
= WEB-INF
B Workflows — Branching block enables th
1| webme_chat_work. workflow [ = Branching li}q:-mch; on vfmg'\
=i webEngagement_Engagems i ' Suppor
t?;‘ g = b Ea:an:mam... 2. Conkactlls branch
- - - avalabie)
*H=s include . 3 Default branch (if
B g7 Interaction Processes da "ContactUs’ conditions. sre
&= META-INF
-2 @
#-= sre-gen -
#1-= WEB-INF 5 Route Inter... |5 Route Inter... #IRoute Inter..
B Worldiows Routedustomers. ., RouteCListomerC.., [lossiiaaetan; .
1] clean.warkfiow
1] decision. workflow Rouke to agent in R-:nute b S-klbd in ed categories (i
L& ‘Customer Service' ice) are mot applic
a-%, def aulk. warkFlow oroup W3
ALl engagesmorkflovw
21| getRESTinfo.workflow
(] noengage.workflow .
A Chat Routing workflow example.
When you alter the strategies, you must save your changes, generate the code, redeploy, and restart your Genesys Web
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Engagement application to apply those changes.

Widgets

Genesys Web Engagement includes three pre-integrated Browser Tier widgets:

* Invitation Widget
e Chat Widget
e Callback Widget

These widgets are based on HTML, CSS, and Javascript, and can be customized to suit the look and feel of your website. When you
create an application, Genesys Web Engagement creates a Composer project that has a directory dedicated to the widgets:
GWE _installation_directory\apps\application_name\resources.

e

The Browser Tier Widgets.

You can customize the widgets using the HTML files in this directory, CSS, or the Notification Service API. You can also build your
own version of a particular widget with the help of the Web Engagement APIs.

Quick Start Guide
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Configuration Options

For a full list of configuration options for the Web Engagement servers, see Configuration Options.

Monitoring Agent API

The Monitoring Agent API is available through the JavaScript libraries provided by the Web Engagement Server at runtime. By
using this APl in your web pages, you can submit events to the Genesys Web Engagement Server, independently from the set of
events and conditions defined in the DSL files loaded by the browser's Monitoring Agents. For more information, see the
Monitoring Agent APl documentation.

Installing Genesys Web Engagement

In order to use the Playground application, you must first install and configure Genesys Web
Engagement and its related components, and then deploy the Playground Application.

For details, see the steps below:

1. Review the prerequisites and make sure your Genesys environment meets the requirements.

2. Install the Genesys Web Engagement Servers. These procedures describe how to install and configure
the Web Engagement Server cluster and nodes.

3. Make sure you have properly configured agents and add agent shortcuts to the Web Engagement Chat
and Web Engagement Voice agent groups: In Genesys Administrator, navigate to Provisioning >
Accounts > Agent Group, and select Web Engagement Chat. Go to the agent tab and click Add to
add the agent to the group. Repeat these steps for the Web Engagement Voice agent group.

4. Install the Plug-in for Workspace Desktop Edition. You can install this plug-in if you want to enable chat

and web callback engagement features so you can see Web Engagement from the agent's perspective
when you test the Playground Application.

5. Install the Plug-in for Genesys Administrator Extension. You can install this plug-in if you want to create
or modify categories when you test the Playground Application.

6. Go to the apps\playground\addons\demo\war\html\ folder and open the instrumentation.html
file in an editor. Modify the following lines to replace demosrv.genesyslab.com with the fully qualified
domain name of your host:

e var serverDefault = 'http://demosrv.genesyslab.com:9081";
* var serverSecure = 'http://demosrv.genesyslab.com:9081";
e domainName: 'demosrv.genesyslab.com',

Save your changes and close the file.

7. Deploy an Application. To complete these procedures, make sure you use the application name
playground.

8. Make sure the components in your Genesys environment are running:
e Configuration Server
* Universal Routing Server

e |Interaction Server
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* Orchestration Server
» Stat Server
* Chat Server
* Interaction Workspace
9. Start the Web Engagement Servers.
10. Login any agents from the Web Engagement Chat or Web Engagement Voice agent groups.

Congratulations! You are ready to run the Playground application.

Running the Playground Application

You can now run the application in any web browser or the InTools application — a GWE tool that
allows you to work with the DSL and view events.

To launch InTools, navigate to GWE _installation_directory/tools/intools/. Take the intools.crx file
and drop it into the Extensions page of your Google Chrome or Chromium browser. Click the
Genesys Web Engagement bookmark in the toolbar and select Playground to launch the
Playground application.

m

- > ¢ [a

.....

= Genesys Site

LE_-—".Z Playaround Quick, Start Documentation PlayGround
demasty . genesyslab, com: 2051/ playgroundfPE. bkl

You can access the Playground application directly from InTools.

To open the Playground application from a web browser, navigate to
http://gwe server host name:gwe server port/playground/PG.html.

* gwe_server_host_ name — The name or IP address of the host for the Web Engagement Server.

e gwe_server_port — The default port for the Web Engagement Server.

For example, http://127.0.0.1:9081/playground/PG.html

Example: Web Chat End-to-End

Complete the steps below for an example of an end-to-end scenario for proactive chat.
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1. Make sure the Playground application is open and you have a logged in and ready agent in either the
Web Engagement Chat or Web Engagement Voice agent groups.

2. Click Engage! next to the Singleton business rule.

Proactive engagement

aingleton Engage!

Timeout 30 Engage!

SEeQUENCE Click here first — Click here to Engage

Sequence Ads Click here first — Click here to Ads

oet Click = Click

Counter (3] Count to Engage

Simple search proactive engagement Search

Search with CatEQDr‘_-,f' what is Search
Click Engage!

3. The chat pop-up appears. Click Chat.

Chat ®

Good afternocon! Would you like some help with the
selection? Cur technical experts are available to answer

Questions
Chat Mo Thanks
Click Chat in the chat pop-up.

4. Fill out the registration form and click Start Chat.
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Please enter few details about you, and press
Start Chat button,

Mext available customer representative will be with
wiou shortly,

*First Marme:
Last Mame:

*Ernail:

= a e e | Skip Registration

Click Start Chat after filling out the registration form.

5. On the agent side, accept the chat. You just walked through your first proactive engagement!

Next Steps

* Working with the Playground Application

Quick Start Guide
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Working with the Playground Application

The Playground application website features a header block and four other functional blocks that can
all be collapsed with a click. You can use the links and buttons in these blocks to trigger chat,

business rules, and business events.

English | Francais

PlayGround

Start page
Change instrurmentation script Y=

Wyidgets customisation 7=

Reactive
engagement

et pacing state for chat

Chatwith pacing €I

Chat without pacing

"=

Proactive engagement

ingleton
Tirmeout 30
Sequence
Sequence Ads
Set

Counter {3)

Simple search

Engage!
Engage!
Click here first — Click here to En
Click here first — Click here to Ad
Click e Clicl

Count to Engage

SYStem events proactive engagement | Sear
Search with categary What is —_—
Page Entered 7=
Page Exited 7=
Quick Start Guide 16



Working with the Playground Application

The Playground application.

PlayGround

The PlayGround header block displays the current page name (Start page in the image above) and
links to the Read Me file for the application.

English | Francais
PlayGround
Start page

The PlayGround header block.

Change instrumentation script

The Change instrumentation script block allows you to configure the instrumentation script on
the fly, so that changes are applied without restarting the Web Engagement servers. For details about
configuring the script, see Configuring the Instrumentation Script.

Change instrumentation script 7=

The Change instrumentation script block.

Customizing Your Widgets

The Widgets customisation block allows you to switch between preconfigured widgets on the fly,
so that changes can be applied without restarting the Web Engagement Server.

Widgets cuslomigsation #=

Widgets customisation guide

Default widgets Custom widyets Widgets, based on templates

e Default widgets—Click this link to use the default GWE widgets.
¢ Custom widgets—Click this link to use widgets with custom CSS.

* Widgets, based on templates—Click this link to use a custom template file for your widgets.
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You can also get more information about how to customize your widgets by viewing the customization
guide that is available from the Widgets customisation guide link in this block.

As you can see here, the customization guide contains a brief description of the major GWE
functionality and information on how to customize your widgets:

Guide

General principles
Instrumentation
Invitation

‘ Widgets
Default termnplates
| Change CS5 on customer page
Change CS5 in widgets
Additional content
Modification lago
Agent avatars

Text messages & localizaton

Authorisation

Back to top

Change CSS on customer page
‘You can modify the style of any element in the widget. In this exampls all modified CSS classes contains on your page.
In this example, Google Chiorme brewser is used (sirmilar diviloper featunes also available in any other moderm browsir)

Start of Procedure
Launch chat widget

Right-click on any element in the widget and click “Ingpect Elernent” to cast the Developer Tools
* 'You can zee that element congists of three elements, each having its own dedicated CSE class. You can create the new styling for these elements.

= You can copy CSS to this textfield (Clhck on text fiakd for edit):

div.gue-chat -eabedded-window { border: 1p= solid #6DS9EE limportant; border-radius: Bpx Bpx Bpx Bpx important;} div.gwe-chat-head {backgr
ound: linear-gradient(to top, 25606568, 2d@d8de) !important;border-radius: Spx Spx @px @px limportant;}

Motice: f you modly default TS5 from wedge! - a0 limporiant sfter class declaration (a5 in exampia).

Launch chat widget for view changes.

Notice: Thi HTML structure and CSS clisses are subfact to change. Gandsys &0 not guararies bachwands cormpatibiiy of tham in the futue varsions, This maans that you may naed 1o
update your customizaiions when updsing the chal widget.

Addditional example | Link to docurnentation with details

Change CS§ in widgets
You can modify the style of any element in the wadget. In this example all modified CSS classes contains in widget template.
+ Create widget prototype with Change CSS on customer page
+ Modify default template.
« 'Vou can modify default or add new CSS classes
default:

<div class=®gwc-chat®s

modified:

Reactive engagement

The Reactive engagement block allows you to initiate chat interactions with an agent simply by

clicking a link.

Reactive

engagement

Get pacing state for chat 7=

Chatwith pacing (XD

Chat withaut pacing

The Reactive engagement block.

The block contains three links that demonstrate reactive chat, with and without the pacing algorithm.

Quick Start Guide
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¢ Get pacing state for chat — Displays true if the pacing algorithm allows reactive chat and false if the
pacing algorithm doesn't allow reactive chat. See Configuring the Pacing Algorithm for details.

e Chat with pacing — Opens a registration form for a chat if the pacing algorithm allows reactive chat.

¢ Chat without pacing — Opens a registration form for a chat, regardless of whether the pacing algorithm
allows reactive chat.

You can modify the code for each of the actions by clicking the related view code button , making
your changes, and then clicking Save.

Proactive engagement

Proactive engagement

Singleton Engage!

Tirmeout 30 Engage!

Sequence Click here first — Click here to Engage
Sequence Ads Click here first — Click here to Ads
met Click — Click
Counter (3] Count to Engage

Simple search proactive engagement Search
Search with category what is Search

The Proactive engagement block.

The Proactive engagement block contains a set of links that trigger business rules. Clicking one of
these links changes the address of the page, the page title, and the name of the page in the
PlayGround header block. In this way, the application simulates a functioning multi-page website.

To trigger business rules, the following conditions must be true:

¢ All system components must work. See Step 8 in Installing Genesys Web Engagement for component
information.

¢ The website must have a properly configured instrumentation script in the Change instrumentation
script block.

« All resources fro the instrumentation script should be available.

¢ There are available agents for the selected media channel.
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¢ The invitation limit (3 by default) should not be exhausted. The invitation limit is set in the Engagement
strategy for the application. See Engagement Policy (Decision Workflow) for details.

Here is a summary of events when you trigger a business rule:

e The application displays the engagement invitation. You can accept, reject, or ignore the invite.
e If you ignore, the invitation disappears. If you reject, the invitation closes.

* If you accept and are logged in (see the User Identification block for details), the application does not
display the registration form and you begin the chat session.

If you accept and are not authorized, the application displays the registration form. If you complete the
registration form, the information is passed on to the agent in Interaction Workspace. If you do not
complete the registration form, you communicate with the agent as an anonymous user.

The Proactive block lets you try out different business rules based on the default rule templates
included with Genesys Web Engagement. See Creating Business Information for details about rule
templates and Deploying a Rules Package for more information about rules.

Business Rule Description

Entrance to the page is specified in the
PlayGround-Singleton category. This example
. demonstrates the interaction of a specific page
Singleton with the business logic.

Category: PlayGround-Singleton
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Timeout 30

Business Rule

Description

'gE-I'-‘ GAX

Categories - Environment

Categories - Environment { >
4 m +
c =2
Hame Description
PlayGround-PageB PlayGround-FageB
PlayGround-Pages PlayGround-Fages
genesys-Logln genesys-Login
genesys-Platform genesys-Platform
genesys-Senices genesys-Senices
genesys-Solutions genesys-Solutions
PlayGround-Singheton PlayGround-Singleton
PlayGround-Ads-Sec PlayGround-Ads-Second

Plaviarm ind-Tirmend m 300 Plaviaromind-Tirmen 30
The PlayGround-Singleton category.

Entrance to the page is specified in the
PlayGround-Timeout30 category. A business rule is
triggered after a 30-second delay. This example
demonstrates the use of the delay on the page.

Category: PlayGround-Timeout30

Quick Start Guide
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Sequence

Business Rule

Description

"E-i GAX

Categories - Environment

Categories - Environment

MHame

PlayGround-PageB

PlayGround-Pages

genesys-Login

genesys-Platform

genesys-Senices

genesys-Solutions

Description

PlayGround-FageB

PlayGround-Fages

genesys-Login

genesys-Platform

genesys-Senices

genesys-Solutions

PlayGround-Singleton PlayGround-Singleton

PlayGround-Ads-Sec PlayGround-Ads-Second

Blavizro ind-Tirmend 30 Plavizroaind-Tirmen m30

The PlayGround-Timeout30 category.

Serial input to the first page First, then on page
Second. The sequence may be any length. For
example, this could be extended to check if all the
necessary pages of a Wizard have been
successfully completed.

Categories: PlayGround-Seq-First and PlayGround-Seq-Second

Quick Start Guide
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Business Rule Description

'gE-I'-‘ GAX

Categories - Environment

Categories - Environment { > PlayGroun
& +
™ -
~ Category Mam
Mame Description PlayGround-
= Category Desc
PlayGround-Seq-First PlayGround-Seq-First
PlayGround-£
genesys-SearchCate genesys-SearchCategory
PlayGround-Counter PlayGround-Counter
Cat Bbatc
PlayGround-Seq-Sec PlayGround-Seg-Second il
Seq-First (en
PlayGround-Search PlayGround-Search
genesys-Contact genesys-Contact
genesys-About genesys-About
PlayGround-Ads-First PlayGround-Ads-First « Show Cat
Language-spe
PlayGround-Paged PlayGround-Paged - . e
SE(-TIPST (&N

The PlayGround-Seq-First category.
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Sequence Ads

Business Rule Description

‘h:"-.i GAX
Categories - E

Categories - Environ

4

Hame

Telstra-shop
Mult-main
multrLanguages
PlayGround-Seq-First
genesys-SearchCate
PlayGround-Counter
PlayGround-Seg-Sec
PlayGround-Search

genesys-Contact

nvironment
ment < 2
m
5 =
Description

Multilanguage-main

PlayGround-Seq-First

genesys-SearchCategory

PayGround-Counter

PlayGround-Seqg-Second

PlayGround-Search

genesys-Contact

The PlayGround-Seq-Second category.

Serial input to the first page AdvertisementOne,
then on page AdvertisementTwo. The sequence

may be any length. For example, this could be used

to display advertisements.

Categories: PlayGround-Ads-First and PlayGround-Ads-Second
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Business Rule Description

"_-_EE GAX

Categories - Environment

Categories - Environment < 2
ol m
o il
Hame Description
PlayGround-5eq-5ec. .. PlayGround-Seq-Second -
PlayGround-Search PlayGround-Search
genesys-Contact genesys-Contact
genesys-About genesys-About
PlayGround-Ads-First PlayGround-Ads-First
PlayGround-PageB PMayGround-PageB
PlayGround-Paged PMayGround-Paged
genesys-Login genesys-Loglin
genesys-Platform genesys-Platform .
i ¥
The PlayGround-Ads-First category.
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Set

Business Rule

=

Categories - Environment

GAX

Description

Categories - Environment

MHame

PlayGround-PageB

PlayGround-Pages

genesys-Login

genesys-Platform

genesys-Senices

genesys-Solutions

Description

PlayGround-FageB

PlayGround-Fages

genesys-Login

genesys-Platform

genesys-Senices

genesys-Solutions

PlayGround-Singleton PlayGround-Singleton

PlayGround-Ads-Sec... PlayGround-Ads-Second

Plaviarm ind-Tirmend m 300 Plaviaromind-Tirmen 30

The PlayGround-Ads-Second category.

Bypassing pages set in any order. The user can go
to PageA, then on to PageB, or vice versa. This
example could be used to demonstrate triggering

business rules when filling in all the fields in a form.

Categories: Playground-PageA and Playground-PageB
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Business Rule Description

'gE-I'-‘ GAX

Categories - Environment

Categories - Environment { > PlayGroun
1 +
< o Category Mam
Hame Description PlayGround-F
= Category Desc
PlayGround-PageB PlayGround-FageB

PlayGround-F

PlayGround-Pagea PlayGround-Pagea
genesys-Login genesys-Login

Category Matc
genesys-Platform genesys-Platform Pageh (en-U!
genesys-Senices genesys-Senices
genesys-Solutions genesys-Solutions
PlayGround-Singleton PlayGround-Singleton

« Show Cats
PlayGround-Ads-Sec PlayGround-Ads-Second

Language-spe
PlavGre ind-Tirmen 30 Plaviromind-Tirren m30 ¥ Pagea (en-Ls

The Playground-PageA category.
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Business Rule Description

'gE-I'-‘ GAX

Categories - Environment

Categories - Environment { > PlayGroun
& +
O iy
~ Category Mam
Hame Description PlayGround-F
= Category Desc
PlayGround-PageB PlayGround-PageB PlayGround-f
PlayGround-Pages PlayGround-Fages
genesys-Login genesys-Login
Category Matc
genesys-Platform genesys-Platform PageB (en-U!
genesys-Senices genesys-Senices
genesys-Solutions genesys-Solutions
PlayGround-Singleton PlayGround-Singleton
« Show Cat
PlayGround-Ads-Sec PlayGround-Ads-Second
Language-spe
Plavirem ind-Tirnen n30 Plavtaromind-Tirmen 130 ¥ Paged (en-LK

The Playground-PageB category.

Counts multiple entries on the same page.

Counter (3) Category: Playground-Counter
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Business Rule Description

"E-i GAX

Categories - Environment

Categories - Environment < 2 PlayGroun
Q
™ -
~ Category Ham
Mame Description PlayGround-{
PlayGround-Seq-First PlayGround-Seq-First i Category Desc
BlayGr -
genesys-SearchCate . genesys-SearchCategory ayGround
PlayGround-Counter PlayGround-Counter
P nd-Seq- P i Tre
layGround-Seq-Sec. .. layGround-Seq-Second Ca ry Matc
PlayGround-Search PlayGround-Search Counter (en-
genesys-Contact genesys-Contact
genesys-About genesys-About
PlayGround-Ads-First PlayGround-Ads-First
« Show Cats
PlayGround-PageB PlayGround-FageB Language-spe

Counter (en-L
1 L3

The Playground-Counter category.

Search for a specific keyword. The keyword is hard-

Simple search coded in the business rule.

Search for a specific keyword. The keyword is
defined by the PlayGround-Search category. A
regular expression can be used to describe the

Search with category keyword.

Category: PlayGround-Search
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Business Rule Description

L"E-j GAX

Categories - Environment

Categories - Environment { > PlayGroun
o] [
o L.
Category Mam
Mame Description PlayGround-&
PlayGround-Seq-First PlayGround-Seq-First - Category Dest
BlayGr -
genesys-SearchCate. . genesys-SeanchCategory ayGround-§
PlayGround-Counter PlayGround-Counter
P nd-Seq- P i Tre
layGround-Seq-Sec. .. |ayGround-5eq-Second Category Matc
PlayGround-Search PlayGround-Search Search (en-U
genesys-Contact genesys-Contact
genesys-About genesys-About
PlayGround-Ads-First PlayGround-Ads-First
« Show Cats
PlayGround-PageB PlayGround-FageB Language-spe
M Search (en-LE
i | ]

The PlayGround-Search category.

User Identification

The User Identification block contains links to send events that are generated by the Monitoring

API. All events in this block can be modified by clicking the related view code button and then
Save. You can use the user information to manage registration (from the registration form for the
authorized user) and send the necessary information to the agent.
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User Identification

Send User Info @
Sign In B
Sign Out 2=

The User Identification block.

This block demonstrates three generated events:

* Send User Info—Send events with user information. You can use this event to identify an authorized
user who has previously visited the site.

¢ Sign In—Send the authorized user login event.

* Sign Out—Send the authorized user log out event.

System events

The System events block contains links that demonstrate the PageEntered and PageExited system
events that are part of the Monitoring JS API. You can modify the code for each of the actions by

clicking the related view code button , making your changes, and then clicking Save.

System events

Fage Entered ?

Fage Exited ?

The System events block.

Important: The PageEntered event updates the current pagelD. Make sure that a PageExited
event is sent before sending a PageEntered event, as it is important for correctly modeling the
actions of a Single Page Application.
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Testing the Playground Application

To give you a better idea of how to use the Playground application, let's walk through an example of

building a "keyword search" scenario.

Test Scenario Steps

Here are the steps in our scenario:

An anonymous user visits the site.

The user enters a search term, "contract", in the search box.
The user browses the search results.

A chat invitation window appears.

The user accepts the invitation.

The user fills out the registration form and submits it.

The user chats with an agent.

The agent sees pages the user visited.

© ® N o Vv A W N+

The agent sends the user a link to a page of interest.

=
°©

The user exits the chat session.

Test Scenario Preparation

Here are the steps to complete before we can walk through our test scenario. Note that for steps 1
through 6, you do not need to take any action if you are using the Playground application, as these
items are covered out of the box.

1. Customize the DSL file with the InTool application.
Complete the steps below to add the events to the DSL file for our test scenario.
Start

1. Open the Playground application in InTools. You can launch InTools by navigating to
GWE installation_directory\tools\intools\. Take the intools.crx file and drop it into the
Extensions page of your Google Chrome or Chromium browser.

2. Press F12 to open the developer tools and select GPE DSL Editor.
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. PlayGround x

& - C [} demosry.genesyslab.com: 2081 blayground/tml Pe Rkl b
Reactive Proactive User info

Singleton Get Engagement!
Tirmeout 30 Get Engagement!
SEQUENCE Fress First Fress Second
Set FPress A Press B
Courter Press
Jimple search proactive engagement search
Search with category Wihat s Search

Q, Elements Metwork Sources Timeline Profiles Resources Audits Console | GPE DSL Editor | SENDR - ] =g, x

1 <?xml version="1.0" encoding="utf-8" 23 Event Console @ ¥ X i

Z <properties>

3 <events

4 <!-— Add your code here

2 <event id="" name="">:

[ <fevent

7 -

] 8|

9 «!-- Thizs is template for your search event --»

10 <l

11 <event id="ZearchEvent" nawe="Zearch">

1z <trigger name="SearchTrigger” element="" action="click" url="!

13 <wal name="searchString” valus="" />

14 </evenk:>

15 -

Simple | = @ Load From Page @ Validate @ Test | @ Unpublish | & Saveas

The left window shows the DSL for Playground application, while the left window shows the events
on the page.

3. Find the "TimeoutEventl0" <event> in the DSL and select the "element" attribute on its
<trigger>. InTool goes into search mode.

4. Select Search. The selector for Search replaces the "element" attribute value. We now have a
trigger for the event in Step 5 of our test scenario: 10 seconds after loading the search results
appears chat invitation window.
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. PlayGround ®

& - C [ demosrv.genesyslab.com: 8021 /playground/html P Rkl 77 =
Reactive Proactive User info
Singleton Get Engagement!
Timeout 30 Get Engagement!
Sequence Press First Press Second
Set Press A Press B
Counter Fress
Jimple search proactive engagerment
Search with category What is search
Q, Elements Metwork Sources Timeline Profiles Resources Audits Console | GPE DSL Editor | = # E‘l
g =t Event Console i
11 <event id="ZearchEvent" nawe="Zearch"> @+ |40
1z <trigger name="SearchTrigger” element="" action="click" url="!
13 <wal name="searchString” valus="" />
14 </evenk:>
15 -
16
17 <event id="TimeoubEventlO™ name="Timeout-10" condition="" po:
18 <trigger name="TimeoutTrigger” elewment="" action="timer:10(
19
20 </event>
Z1
22 <event id="TimeocutEvent30" nemwe="Timecut-30" condition="" po:| |
23 <trigger nawe="TimecutTrigger” elewent="" action="timer:30[
24
25 <fewents
Simple | & @ Load From Page @ Validate ® Test | @ Unpuklish || & Saveas

5. If you select a "value" attribute in the DSL, InTool goes into search mode. Now you can select an
item on the page and the selector for that item will replace the "value" attribute in the DSL.
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.PIayGrnund x
minal | - C' [ demosry.genesyslab.com 80581 /plavground Html PG bl v =
Reactive Proactive User info
Singleton Get Engagement!
Timeout 30 Get Engagement!
SECUENCE Fress First Fress Second
Set Press & Press B
Counter Press
Simple search proactive engagement | cearch
Search with category wWhat is Search
Q, Elerments Metwork Sources Timeline Profiles Resources Audits Console | GPE DSL Editor | i1 0= =g, x
10 Event Consocle W
11 <event id="SearchEvent"” nawe="Search”s AR SN |
1z <trigger name="ZearchTrigger"” element="f#buttond" action="clicl
13 <wal name="search3tring" value="4§i '#inputl ') wal (i " />
14 </event>
i35
16
17 <event 1d="TimeoutEventl0" name="Tiwmeout-10" condition="" po:
18 <ktrigger name="TimeoutTrigger" element="#inputl"” action="t:
19
20 <fevents
21
2z <event id="TimeoutEvent30" name="Timeout-30" condition="" po: |
el <kbrigger name="TimeoutTrigger" element="" action="timer:300
24
25 o fasran o
Simple | &= @ LoadFrom Page @ validate @ Test | (@ Unpublizh | E Save as

6. Click Test to confirm your event works.
End
2. Create categories with the GAX plug-in.
In the steps below we create a category that matches the "contract" search term, Step 2 in our Test Scenario.
Start

1. In Genesys Administrator Extension, navigate to Configuration > Web Engagement >
Categories.

2. Click + to create a new category.
3. Enter the following information:
* Category Name — Playground-SearchWithCategory

e Category Description — Keywords for search

¢ Check Show category in Interaction Workspace to make the category available for agents.
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Mew <X

Category Name * i ]
PlayGround-SearchWithCategory

Category Description i ]

keywords for search

« Show Category in Agent Desktop

o

* Click Save. The new category is added to the list of categories
4. Select the Playground-SearchWithCategory category.
5. In the Category Matching Tags section, click +.
6. Enter the following information:

¢ Name — PlayGround-SearchWithCategory

e Type — Plain Text

* Expression — contact

 Language — Select a language from the list.
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Mew { X

Mame *

PlayGround-SearchWithCategory

Type *
Plain Text

Expression *

contract| ®

Case-sensitive
Language *
English - United States

Save Cancel

¢ Click Save. The tag is added to the Category Matching Tags section.

7. In the Language section, click +.
8. Enter the following information:
¢ Name — PlayGround-SearchWithCategory

* Language — Select a language from the list.
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Mew { X
Mame *

PIa]rGmund-SearchWithCategorfl *
Language *

English - United States

Save Cancel

* Click Save. The language is added to the Language section.
End
3. Configure Genesys Rules System

Complete the following procedures Genesys Rules System to work with Web Engagement.

Configuring Genesys Rules Development Tool

Prerequisites

e Your environment includes Genesys Rules Development Tool (GRDT), deployed as a Composer plug-
in. See Genesys environment prerequisites for compliant versions. For more information about
installing GRDT, refer to Installing the GRDT Component in the the Genesys Rules System
Deployment Guide.

* You enabled the Galileo update site in GRDT, as described in Installing the GRDT Component.
Start
1. Open Genesys Rules Development Tool by starting Composer.
2. Navigate to Window > Preferences. The Preferences window opens.
3. Navigate to Genesys Rules System > Configuration Server. Edit the settings.
e Enter the Configuration Server host name. For instance, localhost.
e Enter the Configuration Server port. For instance, 2020.

e Enter the application name for the Rules Authoring Client application. For instance,
RulesAuthoringClient.

¢ In the Authentication section, enter the name and password for a user who can connect to
Configuration Server and click Apply.

Quick Start Guide 38


https://docs.genesys.com/Documentation/GWE/latest/Deployment/Prerequisites#Genesys_Environment
https://docs.genesys.com/Documentation/GRS/8.5.0/Deployment/InstallingtheGRDTComponent
https://docs.genesys.com/Documentation/GRS/8.5.0/Deployment/InstallingtheGRDTComponent

Testing the Playground Application

i
| type filter text Configuration Server T B
-G I
__ ;zera Settings for Dp-ﬁol."la"‘f connecting to a Configuration Server
- Composer —Host configuration
El Genesys Rules System MName: I localhost
i i Configuration Server
Port: 2020
¢ i-Repository Server o I
. - Template Types Application: | RulesAuthoringClient
[+~ Help
.. Install/Update — Authentication
- Java User name: | default
[#- Java EE
- JawaScript Password I —
-- Plug-in Development
- Run/Debug Advanced
[]- Server ™ Specify TCP dient settings (not recommended)
"TEE'T' ame: |
i-- Validation
- Web Port: | 65535
[+ Web Services
__ ¥ML Test settings
Restore Defaults | Apply |
?) ok | cancel |

GRDT settings for Configuration Server.

4. Navigate to Genesys Rules System > Repository Server. Edit the settings.

Enter the Repository Server host name. This is the name of the host specified for the GRS
application (application with type Business Rules Execution Server) in Genesys CME. For

instance, localhost.

Enter the Repository Server port. This is the port with the ID genesys-rules-engine that is
specified for the GRS application (with type Business Rules Execution Server) in Genesys CME.

For instance, 8020.

Enter the Servlet path as genesys-rules-authoring.

In the Authentication section, enter a name and password for a user who:

* Has Read and Execute permissions for the Genesys Rules Authoring client application (set up
in Configuration Server); this user must have explicit Read and Execute permissions or must
belong to an access group with those permissions.

* Belongs to a Role with the following privileges: Template - Create, Template - Modify,

Template - Delete.
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5. Click Apply.
=10l x|
| type filter text Repository Server G om Lo w
[+ General
__ Ant Settings for ::onnn?a'cﬁng to a GRS repository
__ Composer —Host configuration
El Genesys Rules System Mame: | demasry
i L.gConfi tion 5
on gura n erver Porks |BU?_U
I S . =pository Server
i Template Types Servlet path: Igenesys—rules—auﬁmring
- Help Use HTTPS: [~
- Install/Update
- Java ~ Authentication
- Java EE
: ] i | default
-- JavaScript SEr nams I =ted
-- Plug-n Development Password: | S
[+~ Run/Debug
G+ Server
G- Team
- Validation
[+~ Web
[+~ Web Services
[ XML

Restore Defaults | Apply |

@ ok | el |

GRDT settings for the Repository Server.

6. Navigate to Genesys Rules System > Template Types. If it is not present, add the
web_engagement template type and set Event Support to true. Click Apply.
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= Preferences _ O] x|

It*r'pe filter text Template Types CR A=

- General
-Ant

- Composer

- Genesys Rules System Mame I Event Support I New...
i Configuration Server COMVERSATION_MGR false

Repository Server iwed falze
& Template Types web_engagement true

-Help

-InstallfUpdate

-Java

-Java EE

- JavaScript

-Plug-in Development
-Run/Debug

- Server

Template types are used to determine operating mode of a rule server, as well as
provide a grouping mechanism in the authoring tool

-Team

i Validation

- Web

[+ Web Services
- XML

¥ Show automatic type addition dislogs
Restore Defaults | Apply |

@ o ] co |

Template types in Composer
7. Click OK.

End

Configuring Genesys Rules Authoring Tool

Prerequisites

* Your environment includes Genesys Rules Authoring Tool (GRAT). See Genesys environment
prerequisites for compliant versions. For more information about installing GRAT, refer to the
Genesys Rules System Deployment Guide.

Start

1. In Genesys Administrator, navigate to Provisioning > Environment > Applications, select the
GRAT application (the application with type Business Rules Execution Server), and click Edit.
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vk WN

8.

In the Connections section, click Add....
Select the Genesys Web Engagement Cluster and click OK.
Select the Web Engagement Cluster in the list of connections and click Edit.

In the Connection Info window, select default for the ID field. Click OK.

Connection Info

General Advanced Network Security

* SErver: GWE 85 Cluster x| O
*1D: default (9081) w
Connection Protocol: w
Local Timeout: 0

Remote Timeout: 0

Trace Mode: [Unknown Trace Mode] v
Connection Type: w

ok || cancel

iD is set to the default port.
Select the Options tab.

In the [settings] section, set verify-deploy-address to false. You must set this option because in
Genesys Web Engagement, rule packages are deployed to the Web Engagement Server, not to
Genesys Rules Engine. When set to false, this option prevents GRS from trying to verify that the
server deploying the rules is Genesys Rules Engine.

Configuration I Options | Permissions Dependencies | Alarms Il Logs
| New [f¢Delete - Export o Import View: Advanced View (Options)
Mame = Section Cption Walue
T || Fiter Fiter Fitter Fitter

= settings (6 Items)

settingsigroup-by-level settings group-by-level falze
settings/max-connections settings max-connections 99
settings/session-timeout settings session-timeout 30
settings/session-timeout-alert-interval settings session-timecut-aler... 1
settings/strict-mode settings strict-mode true
I settings iverify-deploy-address settings verify-deploy-address false

verify-deploy-address is set to false.

In the Security tab, set a user who has Read, Create, Change rights for the Scripts folder in Log On
As. This user should also have: Read access to all tenants which are supposed to be used; Role with
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sufficient permissions (as detailed in Genesys Rules System Deployment Guide); Read access to
Business Structure folder and associated nodes that are supposed to be used; Read access to
Scripts folder and Scripts objects (which are representations of the rule templates).

9. Click Save & Close.

End

(Optional) Configuring Roles Settings for Rules Management

You should complete this procedure if you need to import permissions to enable a user to create rules for Genesys Web
Engagement. Once roles are imported, you can assigned them to the user who publishes the rule templates and creates rules for
GWE.

You should not complete this procedure if you have already created a user who has permissions to create rules packages in
Genesys Rules Authoring (as described in the "Role-based Access Control" chapter of the Genesys Rules System Deployment
Guide).

Start
1. In Genesys Administrator, navigate to Provisioning > Accounts > Roles and click New....
2. Enter a name for the new role. For example, GWE_Rules Administrator.

3. In the Memebers section, you can specify who should have this role. Click Add to add as many
access groups or users as you need.

Quick Start Guide 43



Testing the Playground Application

ﬂ GWE_Rules_Administrator - % Roles",

¥ cancel |l Save s Close |ml Save |ml Save & MNew _,é Reload ()

Configuration Role Privileges Permissions

| * General

* Mame; GWE_Rules_Administrator

Description: in GRDT - impart ar create, madify and publish templates, in GRAT - create, madify, delete and
Tenant:

State: Enabled

&« | Members
Uzers: ] add -2 I
Uzer Mame - Agent Last Mame First Mame

Mo objects to display

ACcess Groups: [T) Add -2 ;
Matne - Type
Mo objects to display

New Role

4. Select the Role Privileges tab and select Genesys Rules Authoring Tool. The privileges for
GRAT are added to the GWE_Rules_Administrator role.
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E] GWE_Rules_Administrator - % Roles",

¥ cancel |l Save & Close |ml Save lml Save & Mew _é Reload | ()

Configuration Role Privileges Permissions

E] Al Al 2 Expart 3 Impark
AddfRemove Products [] Interaction workspace

Genesys Rule Authoring Tool
[ zeresys Administrstor

K 1

Marme “alue

T | Fitter Fitter
= Rule Authoring {4 Ikems)

b Creste Rule

P Delete Rule

B Modity Rule
b

“iewy Rule

= Rule Packages {4 Items)
b creste Package

b Delete Package

P Deploy Package

b modify Package

= Rule Templates (3 Items)
B Creste Template

b Delete Template
B Modity Template

=l Business Calendars {4 Items)
¥ Creste Calenchar
b Delete Calendar
b modify Calendar
b wiewy Calendar
Imported Role Privileges
5. Click Save & Close.
End
Members of the GWE_Rules_Administrator role can now do the following:
* Create, modify, and delete rules
* Create, modify, delete, and deploy rule packages

* Create, modify, and publish CEP rule templates
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4. Prepare the CEP Rule Templates.

Complete the following procedures to import, configure, and publish the CEP Rule Templates.

Importing the CEP Rule Templates in Genesys Rules Development Tool

Complete this procedure to import the CEP rule templates in the Genesys Rules Development Tool. Even if you do not plan to
customize the templates, your rule template must be published in the Rules System Repository before you try to create rules.
Prerequisites

* The Genesys Rules Development Tool is installed, configured, and opened in Composer.
Start

1. Navigate to Window > Open Perspective > Other > Template Development to switch to the
Template Development perspective of the Genesys Rules Development Tool.

2. Select File > Import....

3. In the Import dialog window, navigate to General > Existing Projects into Workspace. Click
Next.

4. Select Select Root Directory:, then click Browse.

5. Import your project, located in the folder at Web Engagement installation directory\apps\
playground\resources\_composer-projects\WebEngagement_CEPRule_Templates. Select
the rules template project to import:

* Browse to the \apps\playground\resources\_composer-projects folder in the Genesys Web
Engagement installation directory and select a project.

* Click OK. WebEngagement_CEPRule_Templates_playground is added to the Projects list.
e Select the WebEngagement_CEPRule_Templates_playground project.

¢ Warning: Do not enable the option Copy projects into workspace.
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% Import

Import Projects

' Select a directary o search for existing Eclipse projects,

(¥ Select root direckory: | C:iProgram Files\GCTIVGenesys Web Engagem  Browse...

" Select archive File: | Browse, ..

Projecks:

WiebEngagement_CEPRule_Templates_SSplayground (C:Program Select Al

----- ] webEngagement_CEFRule_Templates_playground {C:\Program Fil
Deselect Al

i

Refresh

4] | i

[ 1 Copy projects into waorkspace

Working sets

[ aAdd project to working sets

Working sets; j Select. .. |

@:l = Back Mext = | Finish I Cancel

Import the default templates by clicking Finish.

¢ Click Finish to import the project. WebEngagement_CEP_Rule_Templates_playground is
added to the Project Explorer.

[ Project Explorer 52 mo T

El@ WebEngagement_CEPRule_Templates_85playground
= Ackions

0[:: onditions

G Enums

---ﬂ}tﬁ Fack Model

@, Functions

E Parameters
WebEngaE;ement_CEP_RuIe_TempIates_pIayground is added to the Project Explorer.

Quick Start Guide 47



Testing the Playground Application

End

Configuring the CEP Rule Templates

Prerequisites

* The Web Engagement Categories business attribute is defined in Genesys Administrator.

Start

1. In the GRDT Project Explorer, right-click on the WebEngagement_CEPRule_Templates project.
Click Properties.

2. In the Properties dialog window, navigate to Template Properties. In Publishing Data, set Type
to web_engagement.

Properties for WebEngagement_CEPRule_Templates H=]

@ Template is reserved by you, ... settings cannok be changed - B

o Resource

""" Builders ID: | ‘wWebEngagement_CEPRule_Templates

----- Project References

----- Refactoring History [ el T B

""" Run/Debug Settings Twpe: Iwel:u_engagement j iConfigure tvpes

----- Server

..... Task Tags Tenant: IEnvianment j
#-FIE Template Properties Description: :I

- walidation

-
1 I

Base vetrsion) 7

@j K I Zancel

Set the type to web_engagement.

3. Navigate to Template Properties > Imports. The Imports panel opens.

4. Select the Enable global imports option.
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: Properties for WebEngagement_CEPRule_Templates H=]

| tvpe filker bext Imports Sl T
i RE_S':""“:E Configures globally available Java import declaration For this template project, Requires wersion
----- Builders 1.1 REST interface
""" Project References ¥ Enable global imparts
----- Refactoring History
----- Run/Debug Settings ~ Impaorts
""" SErver “— cam, genesyslab.wme. cep.api.Event Mew
""" i Task Tags “— com,genesyslab.wme. cep.drools EventDispatcher

[=-EE Temnplate Properties
- Irnpiarks
b Yariables

[+~ Yalidation

Resktore Defaulks | apply |

@:J (] 4 I Cancel |

Enabling global imports.

Note: The com.genesyslab.wme.cep.api.Event and
com.genesyslab.wme.cep.drools.EventDispatcher packages must be present.

5. Click OK.

6. In the Project Explorer, navigate to WebEngagement_CEPRule_Templates > Parameters >
category.

7. In the Parameters Editor panel, set Attribute Name to Web Engagement Categories.
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el Help
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- £ marchiieng .Iinul-ir&
L geors, X2 marrirgs, Oother
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]
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[-1-F-T2

= _"Il =0

DRI
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8. Click Save.

End

Publishing the CEP Rule Templates in the Rules Repository

Prerequisites

e Your user has the correct permissions to manage rules in GRAT, as detailed in the Genesys Rules

System Deployment Guide.

* You configured GRDT to enable a connection to Configuration Server and Rules Repository Server.

Start

1. In Project Explorer, right click WebEngagement_CEPRule_Templates.

2. Select Publish. The Publish Template Wizard opens.
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Template Development - YWebEngagement_CEPRule_Templates_Genesyslab;/Cq

File Edit Mavigate Search Projeck Run  Configuration Server  Window  Help

JC3- | Q- |- |vivie 2800 &8

ﬁ’ | Template Developrent -:g Composer

Tﬁ_ﬁ Project Explorer &3 [—] <u1=*'=f> = Eq(i default, workflow (é_ de
|

ERE

‘webEngagement_CEPRuUle_Tem|

- Actions M y Hitol
°[: Conditions 3o Into
G Enums - Copy e
"'EBtE Fact Model _F'aste o
@, Functions 3 Delete Delete skring
'Eg Parameters e i
E:El"‘:.::jl WebEngagement _ChatRouting EY— - it
{4 WebEngagement_EngagementLe
E ‘WebEngagement_Engagementih @Impnrt, . withe
L Expart. ..
£ | Refresh F5 out :
L eve

Close Project
Close Unrelated Projects

e |

K_‘ .
Li3 GRS Server Explarer & l:‘_é} EEReservatu:uns...

as e
tegor

E Service Information Yalidate

']} Environmment Run As
Debug As
Profile fs
Tearn

v v v v v

Compare ‘With

Restore from Local History.. .
Source g
Configure r

Propetties Alk+Enter

The Publish Template Wizard.

3. Select WebEngagement_CEP_Rule_Templates.
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Publish Template Wizard =]

Project Selection

Select project to publish to the rule repositary

Project | Targek | Tvpe |
& BlueskyRules i Environment COMYERSATION MGR
@OESSampleTemplate 5} Environment WD
&' PFS_Rules i Environment COMYERSATION_MGR
@TestRules ']} Erviranment WD

i" Environment

Edit propetties. ..

@::I Einish I Zancel

Select WebEngagement_CEP_Rule_Templates.
4. Click Finish.
End
5. Create business rules in Genesys Rules Authoring Tool.
Complete the steps below to create business rules in GRAT to use in our Test Scenario.

Start
1. In GRAT, navigate to your site and select New Rule Package
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S (el 1=5'A) . GENESYSRULES AUTHORING (o] -]

Welcome, demo

|En\r\|nnment V] General
i Packa
B [ Environment a;arﬁs com playground — Rule Package
@ ACME Solution Bet
4% BlueSky N [Playground Rules s o
&% Demo Solution ame
= a Playground Package web_engagement :
[ New Rule Package Type
a Premier Finandlal Services Descripfion  [Rules for the Playground application test
@@ sodal scenario.

Template Selected Name Version Version Comment | Modified By Date Modified
2 WebEngagement_CEPF 1 demo Jun 27, 2014 4:35 PM
[ ‘WebEngagement_CEFF 1 demo Nov 7, 2013 7:49 PM
[ WebEngagemant_CEPF 4 demo Mov 6, 2013 3:19 PM
[ WebEngagement_CEPF 3 demo Oct 29, 2013 11:44 PM
l_ WebEngagement_CEPF 2 demo Sep 24, 2013 2:48 PM
Save Cancel Delete

2. Enter the following information:
 Package Name — com.playground
¢ Business Name — Playground Rules
* Package Type — Select web engagement
¢ Description — Rules for the Playground application test scenario.
* Template — Select the Web Engagement CEP template from the list.

¢ Click Save.

3. Select the package you just created and select the Rules tab.
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S Genesys

GENESYS RULES AUTHORING

(o] )

Welcome, dema

| Envircnment

Rules

| Audit Tral

Package History

1]

= @ Environment

‘ General

Name

‘ Description

Phase

Calendar

Pending
Snapshot

‘StartDaIE

End Date ‘

% ACME Solution
@3 BlueSky
% Demo Solution
[E] a Playground
(1) Mew Rule Package

I_Q Playground Rules

@3 Premier Financial Services

| & New Decision Table ” |_& New Linear Rule ” |4 Import Rule

a Social

4. Click New Linear Rule and enter the following information:

Name — Search

Phase — *

GENESYS RULES AUTHORING

£ Genesys

Welcome, dema

|Enwlunmenl

= @ Environment

o3 ACME Solution
% Bluesky
% Demo Solution
= ¥ Playground
rQ New Rule Package

(7 Playground Rules
a Premier Financial Services
@ Social

General Rules | Audit Trail | Package History |
1] Name Description Phase Calendar Pending Start Date End Date
Snapshot
Rule-100 || Search [ B [mone seiectea) | [ e |
|_& New Decision Table | | & New Linear Rule | | 4 Import Rule ‘
| Search “Mdcnll‘lilinn‘v|.ﬁdﬂlﬁlinn|v‘[imp|v
-

Section | Expression | Parameters | ‘ | | ‘
When
Then
Select Save... Cancel

5. Click Add Condition and select "event 'Search' with parameter {category} save as {event}".
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S Genesys

GENESY.S RULES AUTHORING nm

Welcome, demo

|Envilonmenl General | Rules " Audit Trail | liankagé History
1 Name Description Phase . Calendar Pending Start Date ‘ End Date ‘
= (=) Environment Snapshot

@@ ACME Solution | Rule-100 | Search | | 2 | (None selected) | | | | ] ‘

g BlueSky

g Demo Solution

= &% Playground

@ New Rule Package | | 3 New Decision Table H * New Linear Rule || 2 Import Rule |
(7 Playground Rules L& L& L&

& Premier Finandal Services cenrel ,m‘ h ,m‘ I ,m .

:ﬁ Social o =
Category {category} ints {¢ f} times (W t CEPRule_T s_playg 2 J
Precondition: save last event (W, t CEPRule_Tt
Timeout event occures with category {category} (W, t_CEPRule_
category is {category} save as {event} (W {_CEPRule_T _playground)
event 'Search’ with parameter "{searchString)” save as {event) (W t CEPRule_T
event 'Search’ with ing}’ (W t GEPRule_
event 'Search’ with parameter {category} save as {event} (W t GEPRule_T s_playg.
event following {prevEvent} with category {category} save as {event} (WebEr t CEPRule % v
Select Save... Cancel

6. Select "PlayGround-SearchWithCategory" and "$eventl".

(o] .

Welcome, demo

$ Genesys

|Envimnment General Rules Audit Trail Package History
i ‘ Name ‘ Description ‘ Phase ‘ Calendar | Pending Smlplhntl Start Date | End Date |
Em t "
B S Emvronmen |E Rule-100 | Search | I(None selected) | | | | =] |
g ACME Solution
% Bluesky
g Demo Solution
= &} Playground
"1 Mew Rule Package =
j i | & New Decision Table ” | 4 New Linear Rule ‘ | 4 !mport Rule |
% Premier Financial Services Search Add Condition |~ | Add Action |~ | Group |~
g Social
-
Section ‘ Expression | Parameters | ‘ ‘
When I
| event 'Search’ with parameter " gl J.: as ” Feventi ”
e — | | e ——
Then
< >
Select Save... Cancel

7. Click Add Action and select "generate actionable event based on {event}".
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ns

= Genesy GENESYSRULES AUTHORING .
4 lelcome, demo
|‘Envilunmenl General Rules Audit Trail T Package History T
D | Name | Description | Phase | Calendar | Pending Sﬂﬂplhﬂl{ Start Date | End Date |
(B Environment
% i iE Rule-100 | Search | . | (Mane selected) | | | @
% BlueSky
g Demo Solution
= &) Playground
(1) New Rule Package — - = . =
\\‘;J Rules L d New Decision Table ‘ ¥ Mew Linear Rule | L4 Import Rule |
3 Premier Financial Services e Add Condition |~ | Add Action |+ | Group |+
a Sodial
generate acti event (Wi t CEPRufe_ ~
— | Express  @enerate actionable event based on {event) (W _cspmti_ :_playgr |
T T 1
| When i
| event 'Search' with pammehe{ Playground-SearchwﬂhCahegI S3VE a5 | Sevent! I
| Then
< >
Select Save... Cancel

8. Select "$eventl" from the list.
9. Click Save. We now have a business rule for our search with category scenario.

End
6. Deploy rules to the Genesys Web Engagement Environment.

Complete the steps below to deploy your rules to the GWE environment.
Prerequisites

* You started the Web Engagement servers.

Start
1. In Genesys Rules Authoring Tool, navigate to Solution > your rules package > Deploy Rules.
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@ Logon - Genesys Rules Auth: @ Genesys Rules Authoring x

S Genes

| Environment

v | Outstanding Deployments

€« - C | [1192.168.3.189/genesysrules-authoring/findex. jsp

GENESYS RULES AUTHORING

Leployment Histony

Fackage Snapshots
= | Environment

= 6% Playground Selected
[ Mew Rule Package -
= eomplsparound
ki Deploy Rules (5)
4, Search

LATEST

Snapshot Name

Conwnnenk Drate

Reprasents latesk comtents of this rule package Jun 5, 2014 2:57 aM

Creste Snapshot Export Snapshot Delete Snapshot Refresh

014 Genesys Telecommuni

Deploy Mow Schedule Deployrent Shovy Package Source

hts reserved.

2. Select the checkbox next to your rules package in the Package Snapshots section.

3. Click Deploy Now. The Deploy window opens.

4. Select your Genesys Web Engagement Server for the Location.
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5.

End

@ Logon - Genesys Rules Auth: @ Genesys Rules Authoring x

€« - C | [ 192.168.3.189/genesysrules-authoringfindex. jsp

S Genesy GENESYS RULES AUTHORING

| Enviranment v Qutstanding Deployments Deployment History
Fackage Snapshots
= | Environment
= % Playground Selected snapshot Name Comment Date
[ Mew Rule Pack.
) New Rule Package [ LATEST Reprasents latesk comtents of this rule package Jun 5, 2014 2:57 aM
= eomplsparound
i Deploy Rul 5
& Deploy Rul esi(3) Creste Snapshot Export Snapshot Delete Snapshot Refresh
4, Search
Deploy Mow Schedule Deployrent Shovy Package Source

22014 Genesys Telecommunications Laboratories, Inc. All rights reserved.

Click Deploy. The rules package is deployed to the Web Engagement system.

7. Deploy the Playground application.

Warning

Make sure to stop your GWE servers before deploying an application.

Deploying your Application

Start

1.

Navigate to the installation directory for Genesys Web Engagement and open a new console
window.

Type:
deploy playground

End

8. Make sure the components in your Genesys environment are running.

» Configuration Server

¢ Universal Routing Server
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10.

* Interaction Server

* Orchestration Server
» Stat Server

» Chat Server

* Interaction Workspace

. Start the Web Engagement servers.

Start

To start your servers from Genesys Administrator:

1. Navigate to Provisioning > Environment > Applications.

2. Select the Web Engagement Server.

3. Click Start applications in the Runtime panel.

To start your servers using the provided start script (start.bat on Windows and start.sh on Linux):

1. Navigate to the Web Engagement installation directory and launch a console window.
e For Windows, type: start.bat
e For Linux, type: start.sh

End

The Web Engagement Server is started.

Confirm that the test scenario is a success by walking through the Test Scenario Steps.

Other Test Scenarios

You can use the Playground application to complete the following test scenarios:

Entrance to a specific page (Singleton)

Inactivity timeout for the user (Singleton)

Select an element on the page (Singleton)
Search

Get information about user

Successful completion of the wizard (Sequence)
Go to the previous page of the wizard (Sequence)
Repeated input on the same page (Counter)
Send custom event

Changing the type of invitation depending on the status of the user (gold, platinum)
Filling out the form (Sequence)

Display advertisement (Sequence)
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